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Abstract 

Alignment with alignment guides automatically aligns pictures, charts and images with the text. The new discoverable layout options in 

Word 2013 make wrapping text easier to use. Most of the users are familiar with earlier versions of Word. The new versions are made 

to make work much easier and faster. However, the users are not aware of the advantages of the newest versions which are much 

convenient and compatible with the day to day work that we are involved with. Therefore understanding and being up to date with the 

new versions are essential for effective work performance. The assignment focuses on the special and unknown features of the Word 

2013 to make the user aware of its advantages. In this we focused at main fifteen (15) special and unknown features that are useful for 

the user to carry out work effectively. The blog in MS Word 2013 provides a platform in creation of blogs in simple manner, even 

without having a vast knowledge. Also, it facilitates step by steps to user to complete the task without any hassle. Digital signature in 

advance mood facilitates to share the information in more secured Environment among the users. Also, macro in Word 2013 is advanced 

than earlier versions and while providing user Friendly environment. “Insert online Video” is a new feature in Word 2013 and we can 

create more interactive documents and watch an inserted online video without even leaving the document. Further Word 2013 has some 

image editing features that can create some nice images. Generally, we need some type of Reader like Adobe Reader to look at the PDF 

Read-only files. But in Office 2013 we can use Word to save in PDF format and open up PDF files, even make changes to those files 

and save them. Out of these features, One Drive provides the free storage facility online (Cloud) which act as a personal online hard 

drive. Collapse and expand feature especially helpful to work with long and complicated documents as it provides an outline of the 

document. Also the new feature of “present a document online” provides the accessibility to documents for remote users even without 

having word. Track changes feature is important to do suggested changes to the document. 

Keywords: automation, management information system, cloud, microsoft word blog, onedrive, skydrive, accounting information 

system and digital signature 

Introduction 

Automation itself needs proper planning. An organization that 

fails to plan its automation process may lose the benefit derivable 

from automated accounting system. This, therefore, means that 

automation, if well planned should make an organization better 

in all aspects of its accounting activities. In Nigeria, not much is 

known about automation of accounting system (i.e. e-accounting 

system) of organization, especially local ones. This is a great 

challenge before the academic accountants and professionals. 

The earlier this is tackled,  

The better for accounting profession in Nigeria. Currently 

Microsoft Word is one of the key packages of Microsoft Office 

Package. Microsoft Office Package is a product of well-known 

Microsoft Corporation which was found in April 4, 1975 by Bill 

Gates. Microsoft Windows Operating System & Microsoft Office 

Packages are main products of Microsoft Corporation. By now 

they have released number of versions of Windows Operating 

System & Office packages. Evolution of Microsoft word is seen 

below. 

In 1990 

Fig 1 
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Table 1 
 

Evolution of Microsoft Word 

1. Word 1990 to 1995 

2. Word 97 

3. Word 98 

4. Word 2001 / Word X 

5. Word 2002 / XP 

6. Word 2003 

7. Word 2004 

8. Word 2007 

9. Word 2008 

10. Word 2010 

11. Word 2011 

12. Word 2013 

13. Word 2016 

 

2. In 1995 – Office 95 

 

 
 

Fig 2

 

3. In 1996 - Office 97 

 

 
 

Fig 3 
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4. In 2003-Office 2003 

 

 
 

Fig 4 

 

5. In 2007-Office 2007 

 

 
 

Fig 5

 

6. In 2010 – Office 2010 

 
 

Fig 6 
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7. In 2013 – Office 2013 

 

 
 

Fig 7 

 

8. In 2015 – Office 2016 

 

 
 

Fig 8 

 

Very first version of Microsoft Word was developed by Charles 

Simonyi and Richard Brodie under the guidance of Bill Gates in 

1981. In 1983 Word 1.0 was released for Xenix operating system 

and MS-DOS, but this was not successful. When windows 3.0 

were released in 1990, they released Microsoft office package 

comprising Word 1.1, Excel 2.0 & power point 2.0. This word 

version was released at price of USD 498. At the beginning 

Microsoft Corporation named packages using version number 

such as Word 1.0, Word 1.1, Word 5, Word 6 etc. From year 1995 

on words company used the year to name its versions such as 

Office 95, Office 97 etc. However there are office packages 

named different ways such as Microsoft Office XP. From year 

1995, company has been introducing various versions of word 

packages with higher number of features and facilities. Latest 

version is Microsoft Office 2016 which was released for 

operation system 

 X on 09.07,2015 for Office 365 and licensed version was 

released on 22.09.2015. Microsoft word 97, 98, 2000, 2001 

carried similar basic features. In the XP version, they introduced 

a new major feature of “Task Panels” that give quick information 

and control of features promptly. 2007 word package was 

introduced with number of additional features like XML based 

file format, redesigned interface, bibliographic management etc. 

Word 2008 was released on January 15, 2008 with some 

additional features like ribbon-like that can be to select layouts. 

Word 2013 was released with additional features to focus on 

cloud computing with documents being saved automatically to 

OneDrive (formerly SkyDrive), Opening PDF documents, 

keeping bookmarks etc. Latest version of word 2016 has more 

features rather than word processing. Features like drawing tools, 

Adding graphics, Smart lookup, availability of encyclopedia such 

as Wikipedia, features like “Tell me what you want to do”, 
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facility to work two more people in same word document at the 

same time. 

 

Get on the Cloud 

One Drive option in Word 2013 was previously known as 

SkyDrive. One Drive is a separate storage facility connected to 

the cloud. These storage facilities are freely available online for 

the user. It allows 15 GB of free storage space for each user and 

this opportunity is provided for those who have created a 

Microsoft user account. User can use this to store all types of files 

in one place, and it is compatible with any devices when you wish 

to get them. 

One Drive easily allows you to share files, photos and videos with 

friends and family, and compatible with Windows and Office. 

User can upload files on One Drive; once information is shared 

your colleagues can view them or make basic edits using the 

Office Online/Office Web Apps via an Internet browser. This can 

be done by sending an e-mail with a link to what you’d like to 

share and the link allows sharing only the respective document. 

This becomes a useful option when you need to open a document 

on your smart-phone or tablet, and when you don't have the latest 

version of Word installed on your devices. When you go back to 

your work on computer, you can open the documents you saved 

to One Drive directly from Word. 

 

Sharing, collaboration, and editing features   

There are many options involved in Word 2013 it allows you to 

create, edit and approve the word documents. It’s sharing and 

collaboration facilities are very useful. SkyDrive/OneDrive is the 

option used to share a document with another person directly 

from Word. This will allow another person to open and change 

the documents that has been shared by the other. Another useful 

sharing feature is that, even without having the same technology 

(updated version of the Word), the users can have access to open 

and edit the shared documents or works via office Web Apps. 

Once link related to OneDrive had been sent to the user via email, 

it provides opportunity for user to open the link via Web App. It 

provided accessibility to the other user to edit the view or edit the 

Word document. 

 

Read Mode 

A new “Read Mode” feature is a new option which gives user to 

read documents easily in Word 2013. Earlier version of Word is 

more time consuming as it takes more time reading documents, 

making changes to them and creating new ones. The tools 

available in the ribbon are less useful to you. Read Mode expands 

the reading space containing more content in the document. Read 

Mode removes all of the tool bar menus in Word to provide a 

minimalist, distraction-free view of Word. This feature provide 

option to hide the reading toolbars allowing user to displays 

documents by adjusting the columns or setting the page color to 

sepia or white on black. Text reflows automatically in columns, 

making Read Mode ideal for reading a Word document on a 

Windows laptop or tablet when you're on the road. Read Mode is 

not a feature in Office Web Apps, however, so it won't work if 

you're using a non-Windows tablet. Column widths and 

background colors are easily adjustable in read mode. 

Simultaneous tasks can be adopted in read mode, while reading a 

document can go for another task in which Word will save your 

place in the document so you can pick up later even if you are 

reading the document on another device (like your home 

computer or Windows tablet). You do not even have to hit "Save" 

or insert a virtual bookmark; Word does all the work for you. 

 

Insert Online Video 

In Word 2013, it is possible to insert videos directly in to the 

Word document. A video can be inserted using three methods.  

1. By searching Bing for videos 

2. By other Video services such as YouTube 

3. By using the embed code for a Video 

 

a. Bing/ YouTube Video Search: Following steps should be 

followed.  

1. Enter the type of the Video search into the Search Box and 

click the Search button. 

2. Videos that match the Search Term will be displayed in the 

window. 

3. When a Video is selected, click the Insert button on the 

bottom right side of the window.  

4. The Video will be appeared in the Word document. 

 

b. From a video embed code: A video with an embed code 

needs to be inserted in the Embed Code box here and click 

the Insert button. 

 

Format Video 

The Video can be formatted in the same way that images are 

formatted by using the buttons on the Picture Tools Format Tab.  

 

Improved features for working with images: With Word 2013 

we can search in Word itself for online pictures using Bing. Click 

Insert, then Online Pictures and enter a search term in the Bing 

Image Search box. Microsoft Word 2013 has special image 

editing features that will help to correct and improve our pictures. 

A picture or image can be inserted to the document using ‘Insert’ 

tab. Under the heading ‘Picture Tools’, following special features 

are appeared in the ‘Format’ tab. 

1. Remove Background: This option will let to selectively 

remove portions of a picture if it is needed.  

2. Corrections: From ‘Corrections’ we can sharpen, soften, and 

adjust the brightness of image for better on screen 

presentation. 

3. Color: Different color effects can apply to make the picture 

look more fascinating. 

4. Artistic Affects: This option provides 23 special effects, such 

as pencil sketch, blurring, charcoal sketch, paint strokes, etc. 

This make picture appear to have been made from various 

mediums. 

 

Improved features for working with images 

Open PDF files in Word 

Generally, we need some type of Reader like Adobe Reader to 

look at the PDF Read-only files. But in Office 2013 we can use 

Word to save in PDF format and open up PDF files, even make 

changes to those files and save them. To carry out a conversion 

click on the File tab, select Open, select the PDF file and then 

click OK. Word will convert the PDF to an editable Word 

document which will take a few minutes. Now PDF file is in 

editable form. When we save the file Word we can opt to save it 

as a PDF file. In Word 2013 there are some options before 
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clicking Save. They are Standard (publishing online and 

printing), minimize size option (if it is only going to appear 

online) which is deal for posting on a web page. When we click 

the Options button, there are a number of different options. They 

are page range, published what; include non-printing information 

and PDF options. Also we can encrypt the document with a 

password if needed. 

 

Editing PDF documents 

Collapse and expand a document 

In Word 2013, when we use Styles, the respective Headings in 

documents we can use is a smarter object called collapse and 

expand. This new feature allows collapsing part of the word 

document and expanding it when we want to view that content 

again. This is useful when work with long and complicated 

documents. By using this feature we can display summaries of 

the word document and if the reader is interested to get further 

information under one heading he/she can open the summary and 

read it. This feature is user friendly, as it makes easier to find and 

view only what the reader wants. Also this is useful for view an 

outline of the document and reorganizes the document. Following 

are the steps to follow to activate the above option, 

1. Create the Headings as you would normally, using Styles 

from the Styles group. 

2. Once the style has been applied to a Heading, a small arrow 

will appear near the heading. 

3. Click the triangle again to expand that part of the document. 

 

When you collapse a heading, only the content up to the next 

heading of equal or lesser value is collapsed. Therefore it 

provides a quick way to expand and collapse at once. Following 

steps can be follow to do so. Below are Annexure 14, Annexure 

15 and Annexure 16 respectively: 

1. Right-click the heading and click Expand/Collapse 

2. Expand All Headings or Collapse All Headings. 

 

Collapse and expand a document 

Present a document online 

This is also a new feature introduced in word 2013 to share 

documents online. Through this object we can present documents 

online even though users don’t have word. Also there are some 

other facilities available such as give comments on the document 

online, download the document and also can edit the document. 

Following steps should be followed, 

1. Open ms word 2013 

2. Select the blank document template. 

3. Create a document and select the file menu. 

4. Select the share option 

5. Select present online option 

6. Present online dialog box will appear. 

7. URL is given for the document and can share the link 

8. Copy the link and paste it in any web browser and you will 

see that document is presented Online 

9. Then click on the start presentation button. 

 

When the remote user click the hyperlink, a browser window will 

open and the document will be displayed even though they have 

not Word or any other product installed on their computer. 

 

Present a document online 

Simplified markup of tracked changes 

Track changes feature is important tool for making and 

suggesting changes to a document. Although the same feature 

was available in previous versions, the way that markup changes 

appear in word 2013 is different. This feature is very useful for 

writers to make proofreading and editing the document. When 

working in a team or as individuals across the countries can pass 

the same document to make changes. But in word 2013, there is 

a distinguish feature named “lock track changes” which can also 

prevent from making changes to the document. In new version 

suggested changes are not appeared as colored mark up. Instead 

of that red colored vertical line shows to the left of paragraph 

indicating that there are changes in the document. Suggested 

changes can be accepted or rejected by the writer. In new version 

it will reduce the confusion and make easier to compare the 

original text with suggested one. The “Comment” option had 

been dealt in a more innovative way. It provides opportunity for 

the user to give feedbacks by replying to the comments. It 

provides more interactive option for the users to use the Word 

more effectively. Word 2013 displays comments as a thread. In 

Simple Markup, small speech icons popup when there are 

comments being made. You can click on the icon to open up a 

separate window to provide feedback to the selected comment. If 

you've already addressed a comment, you can mark it as "dealt 

with" and gray it out so it isn't distracting. Following are the steps, 

1. Go to Review Tab. 

2. Click the Track Changes button in the Tracking group to 

activate markup of tracked changes.  

3. Make the necessary changes to the document. Each 

paragraph that has a change will show a thin red line left of 

the paragraph to indicate that a change has been made in the 

paragraph. 

4. Accept or reject changes. 

 

Simplified Markup of Tracked Changes 

The new design tab 

Extension of Document formats can be achieved by choosing 

Colors, Themes, and Fonts to use with them. If you come up with 

something you’d like to use all the time, the new Set as Default 

option allows you to make the current combination of formatting 

settings the default for all new documents. The new Word 2013 

Design tab consolidates all the styling tools in Word 2007 and 

Word 2010 into one tab, so that they can be easy to find and easy 

to use. Previewing a document style before applying it to the 

entire document is now possible through the help of the visual 

element that have been added to the Document Formatting tool 

(Bradley, 2013) [1]. There are a lot of variety options in the new 

document format designs to choose from. The only way to get a 

tab character to appear in your document is through the use of 

Leader Tab Stop. A leader tab stop is very useful in producing a 

row of dots where the tab character appears. You can apply a 

leader to any tab stop in Word other than the bar tab (Gookin, 

2015) [3]. Below are the steps to follow when you want to add the 

dot leader to a tabbed list you have created: 

1. Select the text. 

2. Bring forth the Tabs dialog box. 

3. Select the tab stop from the Tab Stop Position list. 
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4. In the Leader area, choose the leader style. 

5. Click the Set button. 

6. Click OK. 

 

The new design tab 

New Design tab includes document formatting options to format 

the entire document. 

Source 

Bradley H. (2013) [1]. 

Below are the steps to follow when Setting Leader Tab Stops in 

Word 2013: 

1. Select the text: There are a number of ways to select text. Use whatever method you find most comfortable. 

 

 
 

Fig 9 

 

2. Bring forth the Tabs dialog box. The Tabs dialog box offers tab options

 
 

Fig 10 
 

3. Select the tab stop from the Tab Stop Position list. The right tab stop shows up in the Tab Stop Position list as 4″ (create a right tab 

stop at 4” if it doesn’t already exist). Click to select that item in the list. 

 

http://media.wiley.com/Lux/29/363129.image0.jpg?h=357&w=311
http://media.wiley.com/Lux/30/363130.image1.jpg?h=357&w=311
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Fig 11 

 

4. In the Leader area, choose the leader style. None means no leader, and it's selected already. Choose one of the other three options. 

 

 
 

Fig 12 

 

5. Click the Set button. Don't click OK before you set the tab stop to add the leader. This step is the one you'll screw up most often. 

 

Click OK 
 

Fig 13 

http://media.wiley.com/Lux/31/363131.image2.jpg?h=357&w=311
http://media.wiley.com/Lux/32/363132.image3.jpg?h=357&w=311
http://media.wiley.com/Lux/33/363133.image4.jpg?h=357&w=311
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After clicking the Set button, you can click OK to close the Tabs 

dialog box and gawk at your text. The leader tab that uses the 

underline character is also the best way to create fill-in-the-blanks 

forms. Use the Tabs dialog box to set a left tab stop at the far right 

margin (usually, 6.0 inches). Choose an underline leader for that 

tab. Click Set and then OK. 

 

Alignment with alignment guides 

The new Alignment Guides in Word 2013 show you when 

movement of an object like Chart, Image, or SmartArt illustration 

in a document is lined up with other elements on the page. If you 

have text wrapping set to an option such as Square, the Alignment 

Guides also show when the object is aligned with the top of a 

paragraph or to a heading. The new feature in Alignment Guides 

makes it a certainty to line up images and other objects in Word 

2013. The alignment guides also show you when the object is 

lined up to key page locations, such as the edge of the page and 

the left and right margins (Bradley, 2013) [1]. Alignment Guides 

automatically appear when an Image, Chart, or SmartArt 

illustration is moved around a document to line up with other 

elements on the page. The new feature in the new version of Word 

2013 is Alignment Guides. When we need any Alignment Guide 

it pops up and disappears when we are done. Professionally, it 

automatically aligns pictures, charts and images with our text thus 

in this way it provides the polished look with the text. Below are 

the steps to follow when using Alignment Guides: 

1. Go to Microsoft Word 2013. 

2. Select the Blank document template from the available 

templates. 

3. Now create a document and take some pictures in it. 

 To insert the picture just select the insert menu option. 

 Now select the pictures menu option from it. 

 Now select the location of the picture in the insert Picture 

Dialog box and click on the insert button in it. 

 An image will be inserted like this. 

4. Now to align the image along with the text we will move the 

image around. 

5. Then a green line will appear automatically to show the 

alignment of the image along with the text. 

6. We will see that it disappears automatically when the picture is 

aligned with the text.  

This feature is really one of the most important features of the 

Microsoft Word 2013. In the previous versions of Microsoft 

Word, we need to set the alignments by ourselves but in this new 

version of Word 2013 it provides the automatic alignments of the 

images, charts etc. along with the texts present in the document 

(Goyal, 2012) [4]. 

 

Alignment with alignment guides 

New Alignment Guides in Word 2013 show you when an object 

is lined up with another object or page element. Below are the 

steps to follow when using Alignment Guides: 

Step 1 - Go to Microsoft Word 2013. 

Step 2 - Select the Blank document template from the available 

templates. 

 

 
 

Fig 14

 

Step 3 - Now create a document and take some pictures in it. 
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Fig 15 

 

 
 

Fig 16 

 

 
 

Fig 17: Now select the pictures menu option from it. 
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Fig 18: Now select the location of the picture in the insert Picture Dialog box and click on the insert button in it. An image will be inserted like this. 

 

Step 4 - Now to align the image along with the text we will move the image around. 

 

 
 

Fig 19 

 

Step 5 - Then a green line will appear automatically to show the alignment of the image along with the text. 
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Fig 20 
 

Step 6 -We will see that it disappears automatically when the picture is aligned with the text.  

 

 
 

Fig 21 

 

Discoverable layout options 

Feature such as wrapping text around an illustration is now much 

easier to use as a result of the new layout options in Word 2013. 

With the use of Discoverable Layout Options, controlling the 

location of the object is now possible by using the Move with text 

or Fix position on page. Even though Discoverable Layout 

Options are available now, we will not stop using the old Layout 

dialog, because it offers other options for positioning the object 

on the page, and you can easily open it by clicking on See more. 

In using Discoverable Layout Options to select text wrapping 

options such as Tight, Square and through, you first of all click 

an image, or a chart, or a SmartArt object in the Word document 

for a Layout Options icon to appear outside its top right corner, 

you then click on that icon. As with the other applications in the 

Office 2013 suite, a formatting task pane opens when you right-

click an object and choose, for example, Format Picture or 

Format Shape (Bradley, 2013) [1]. This stays open as you work 

and shows formatting options relevant to the currently selected 

object. In summary, the New Design Tab, Alignment and 

Alignment Guides, and Discoverable Layout Options have made 

Microsoft word 2013 more sophisticated and easy to use. 

 

Ms Word Blog 

In Word 2013, it provides convenient platform in creating of a 

blog page. Also, it facilitates surprise number of platforms out of 

the box. Writing up of the blog post is also simple, since the user 

has the opportunity to use the editing tools he /she familiar in the 

MS Word. Following are the key steps, 

1. Double click on the blog post template on the top of screen. 

2. Set up a blog account enabling word, how and where to post 

the contents. 

3. Select the platform on which your blog is running on and 

then click next 

4. Since then you will have some kind of URL, so that word 

knows where to post your contents. It is important to 

remember the user name and password which is needed to 

check “Remember me” checkbox. 

5. Then you can write up the blog post using your familiar 

editing options in MS Word. 

6. Then you just click on “Publish” and post to go live 

immediately.  
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You can also log on to admin section and see the waiting post. It 

is important to insert correct HTML tag wherever using the 

familiar word formatting options. 

 

Digital Signature 

This facility is included in the MS Word 2013. This can be 

described a digital code generated and & authenticated by using 

a public key encryption that can be attached to an electronically 

transmitted document to verify its contents and the senders 

identity. Key steps are as follow, 

1. Click File and then Info. Then Protected Document and then 

click on add a digital signature. 

2. In the Sign window, in the Commitment Type, drop down 

and select the required function. Also, enter your purpose for 

signing the document. 

3. Then click on Details and add the details of signer. Provide 

the additional information and click Ok. 

4. Then in Sign window click Change. Then in the windows 

security select the document and click Ok. 

5. To see information about the signer, you can go to file> 

information > view signatures. 

 

Macro 

This option in MS Word 2013 help to automate frequently used 

tasks. Macro is series of commands and instructions that grouped 

together as a single command in order to perform a task 

automatically. Steps are, 

1. Click on View tab, then locate the Macro & click on it. Then 

click on Record Macro. 

2. Then enter the appropriate macro name. Then click, Ok > 

Insert > Table. 

3. Click & confirm the selection. When the table is created go 

to View tab click on Macros > Stop Recording. 

4. Then click on View macro to see it. Then select the macro 

and select Run to execute the macro. In conclusion, without 

the world of computer, all these works (Nwokwu, 

Dharmadasa, and Rathnasingha, 2018; Nwokwu, 2019 

1.A.1; Nwokwu, Rathnasingha and Pradeep, 2019; Nwokwu, 

2019 1.A.4; Nwokwu, Atapattu and Azeez, 2019; Nwokwu, 

2019 1.A.5; Nwokwu and Atapattu, 2019; Nwokwu T. C. 

(2018); Nwokwu, 2019 2.A.7) and other works will not be 

online. 

 

Discoverable layout options 

A picture, chart, or SmartArt object and the new Layout Options 

icon let you configure placement and text wrapping options for 

it. 
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